
INSTRUCTION MANUAL 

Model  

610A Dynamic Muscle Control  

Program Version: 5.400    

November 21, 2012  

Aurora Scientific Inc. 
360 Industrial Parkway South, Unit 4 

Aurora, Ontario, Canada L4G 3V7 

Toll Free: 1-877-878-4784 

Telephone: 1-905-727-5161  

Facsimile: 1-905-713-6882 

Email: info@AuroraScientific.com 

Web site: www.AuroraScientific.com

http://www.aurorascientific.com/
http://aurorascientific.web9.hubspot.com/Default.aspx


INSTRUCTION MANUAL PAGE 1 OF 42 
MODEL 610A 

DYNAMIC MUSCLE CONTROL VER: 5.4000, REV. 0 
  

  

File: 610A.v5.400.Manual.docx      Aurora Scientific Inc., 2012 

Table of Contents 

Table of Contents ................................................................................................................. 1 

Table of Figures ................................................................................................................... 2 

Software Activation Procedure ............................................................................................ 3 

1.0 Introduction .................................................................................................................... 5 

2.0 Specifications ................................................................................................................. 6 

3.0 Quick Start Guide .......................................................................................................... 7 

3.1 Instrument Setup ......................................................................................................... 7 
3.2 Turning on the PC and Using the Desktop ................................................................. 7 
3.3 Starting the 610A DMC Program ............................................................................... 8 

3.4 Using the 610A DMC Program .................................................................................. 9 

4.0 Main Program .............................................................................................................. 12 
4.1 Main Screen .............................................................................................................. 12 

4.1.1 Graphics Window ............................................................................................... 12 
4.1.2 Control Buttons .................................................................................................. 13 

4.1.3 Text Readout Boxes ........................................................................................... 15 
4.1.4 Test Progress and Status Line ............................................................................ 16 

4.2 Main Menu ............................................................................................................... 16 
4.2.1 File Menu ........................................................................................................... 16 

4.2.2 Setup Menu ........................................................................................................ 16 
4.2.3 Protocol Editor ................................................................................................... 24 
4.2.4 Sequence Editor.................................................................................................. 28 

4.2.5 Help Menu .......................................................................................................... 30 

5.0 Live Data Monitor........................................................................................................ 31 

5.1 Onscreen Controls .................................................................................................... 32 

6.0 Analysis........................................................................................................................ 34 
6.1 Onscreen Controls .................................................................................................... 34 

7.0 Installation of a New Version of the 610A DMC Program ......................................... 37 

8.0 Technical Support, Warranty and Repairs ................................................................... 38 
8.1 Technical Support ..................................................................................................... 38 
8.2 Warranty ................................................................................................................... 38 

8.3 Returning Products to Aurora Scientific Inc. for Repair .......................................... 39 

Appendix A - 610A File Structure ..................................................................................... 41 
Data File Structure ...................................................................................................... 41 

Protocol File Structure ................................................................................................ 41 
Sequencer File Structure ............................................................................................. 42 



INSTRUCTION MANUAL PAGE 2 OF 42 
MODEL 610A 

DYNAMIC MUSCLE CONTROL VER: 5.4000, REV. 0 
  

  

File: 610A.v5.400.Manual.docx    Aurora Scientific Inc., 2012 

Log File Structure........................................................................................................ 42 
 

 

Table of Figures 

Figure 1 ASI Product Activation Website ...........................................................................4 
Figure 2: 610A Main Window .............................................................................................8 
Figure 3: Protocol Editor Window .....................................................................................10 

Figure 4: 610A DMC Main Window .................................................................................12 
Figure 5: My Instruments Window ....................................................................................17 

Figure 6: Calibration Editor Shown Calibrating a 300C ...................................................18 
Figure 7: Channel Setup Window ......................................................................................21 
Figure 8: Instant Stim Setup ..............................................................................................23 
Figure 9: Protocol Editor ...................................................................................................24 

Figure 10: Sequence Editor Window .................................................................................28 
Figure 11: Select Protocol File Window ............................................................................29 

Figure 12: Live Data Monitor Window .............................................................................31 
Figure 13: Analysis Window .............................................................................................35 

 

  



INSTRUCTION MANUAL PAGE 3 OF 42 
MODEL 610A 

DYNAMIC MUSCLE CONTROL VER: 5.4000, REV. 0 
  

  

File: 610A.v5.400.Manual.docx    Aurora Scientific Inc., 2012 

Software Activation Procedure 

 The 610A Dynamic Muscle Analysis software must be activated before it can be used.  

Activation allows us to provide you with superior service and product updates.   

  

 To activate the software, you will need your serial number, and product key.  These can 

be found on the foil S/N tag affixed to the PC or to the jewel case containing the software DVD.  

Below is an example of these.  

 

Serial: 610001 

Product Key: 017C8 

 

 Upon starting the software for the first time, you will be presented with the software 

activation window.   

 

1. Enter the Serial number and Product Key. The program will return a 15 character activation 

key, copy or write this down. 

2. On a PC with internet access, point your web browser to: 

http://www.AuroraScientific.com/activate 

3. Enter the Activation Code returned by the program, your contact details and then click on 

the Activate! Button, see Figure 1. 

4. Copy or write down the 16 character license code returned by the webpage.  The code is 

unique to your computer and cannot be used on anther machine. Additional licenses must 

be purchased for use on multiple machines. 

5. Enter the license code on the activation window to complete the activation process. 

6. Once complete, exit and reopen the application. 

7. Repeat as required for additional ASI software.   

 

Should you encounter any issues with this procedure, please contact ASI by phone or email, and 

we will be happy to help you with this process. 

  

http://www.aurorascientific.com/activate
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Figure 1 ASI Product Activation Website 
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1.0 Introduction 

The 610A Dynamic Muscle Control (DMC) software was designed to enable physiology 

researchers to study the dynamic mechanical characteristics of muscle tissue.  The system is 

capable of controlling and taking data from all of our 300C series muscle levers, our 400A series 

of force transducers and our 700A series of stimulators.  The 610A software can also be used 

with other manufacturer’s instruments.  A unique feature of our 610A software is its ability to 

create arbitrary length, force, and stimulation control signals.  You are not limited to simple 

square waves, sine waves, or fixed-frequency stimulation.  

 

DMC has an easy-to-use graphical user interface and is written using the LabVIEW 

programming language.  The software collects high-resolution length and force data while 

controlling the length and force of the muscle tissue under test.  Collected data can then be 

plotted and analyzed within the program.  The 610A program also includes a real-time scrolling 

display of the current length and force.  This scrolling display can be frozen at any time and then 

up to 30 minutes of data can be reviewed.   

 

The 610A software was designed for use with a National Instruments PCI-6221 card, 

though it will work with a wide range of National Instruments DAQ products.  This card features 

16-bit accuracy on the eight differential analog input channels (A/D) and on the two analog 

output channels (D/A).  The use of a 16-bit A/D and D/A ensures that the 610A Dynamic Muscle 

Control measures and controls length and force to the resolution of our instruments. 
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2.0 Specifications 

Model: 610A Dynamic Muscle Control 

Minimum Requirements for the PC 

 Processor: Dual-Core Intel or AMD. 

 RAM: 2 GB. 

 Hard Disk: 40 GB. 

 Operating System: Windows XP. 

Recommended PC Specifications 

 Processor: Quad-Core Intel or AMD. 

 RAM:  4 GB. 

 Hard Disk:  500+ GB. 

 Operating System: Windows 7, 32-bit. 

A/D Card 

 Analog Input 

 Number of Channels: 8 differential input. 

 Resolution: 16 bits (1 part in 65536 parts). 

 Maximum Sampling Rate: 100,000 samples per second.  

 Analog Output 

 Number of Channels: 2. 

 Resolution: 16 bits (1 part in 65536 parts). 

 Maximum Output Rate: 100,000 updates per second.  

 Digital Input/Output 

 Number of Channels: 24. 

 Type: TTL. 

Operating System 

 Type: Windows XP/Vista/7. 

ASI610A Software  

 Version: 5.400 

 Programming Language: LabVIEW 

 Interface: GUI, drop down menus. 

Menu Structure:  

File: Save Current Data, Live Data Monitor, Open Log Folder, Exit. 

Setup: My Instruments, Channel Setup, Instant Stim, Enable Input 

Triggers, Enable DMCv4.x Data Files, AutoSave Folder, 

Normalization. 

Analysis:  (future functionality) 

Protocol: opens protocol editor 

Sequencer:  opens sequencer 

Help: Topics, About. 

Protocol Functions: Step, Ramp, Sine Wave, Sum-Sine Wave, Stimulus, Trigger, Stop. 
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3.0 Quick Start Guide 

 The Quick Start Guide will help you set up and start using your new software by 

explaining how to complete some of the most common tasks.  In order to get the most out of 

your new Dynamic Muscle Control software we recommend that you read this entire manual. 

3.1 Instrument Setup 

Locate the PC with 610A software near the measurement electronics. The normal criteria 

for locating a PC should be followed including ensuring adequate ventilation for cooling along 

with protection from water, dust, dirt, vibration and shocks.  Note: If you purchased the 610A 

software with a PC then both the PC and DMC were completely configured at our factory; you 

do not need to install any software.  The 610A software runs under Windows, and therefore most 

Windows compatible software should run without issue on the same PC with 610A.  However 

we do not recommend running other software at the same time as 610A due to the performance 

requirements of 610A. 

 

See the 604A A/D Signal Interface Manual for instructions on connecting your dual-

mode lever system (or a length controller and force transducer) and stimulator to the 604A A/D 

Signal Interface.  The 604A comes with all the cables required to make these connections.  The 

604A manual also provides instructions on connecting the ribbon cable from the back of the 

604A Interface to the A/D card located in the PC.   

3.2 Turning on the PC and Using the Desktop 

Once all components of the system have been connected together in the correct manner 

turn on the PC (power switch is located on the front panel).  Turn on the monitor as well.  The 

PC should go through the normal power on self-tests and then the Windows operating system 

should be loaded.   

 

 If you purchased a 601A Windows PC with your 610A software, you will find the 

following icons on your desktop. 

 

DMCv5.400:  Used to start the Dynamic Muscle Control software. 

 

DMAv5.101: Used to start the Dynamic Muscle Analysis software. 

 

Measurement & Automation: Used to open the Measurement & Automation Explorer tool from 

NI.  This allows you to verify correct operation of your DAQ 

card. 

 

Documentation: Contains a number of files pertaining to the use of DMC/DMA 

and includes example protocols and data files. 
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3.3 Starting the 610A DMC Program 

To start the 610A program click on the icon labeled DMCv5.400. When the program 

starts you may be asked to activate the software before continuing.  If so then please refer to 

Software Activation found on page 3 of this manual.  

 

Once you’ve activated your copy of 610A, you will be presented with the main window.  

This window can be repositioned, maximized, minimized and stretched using the normal 

Windows controls for manipulating the display window.  The main page provides access to all of 

the menu items and also contains a large graphing area for the display of data taken during a test.  

A menu bar is located along the top of the screen that includes the following main menu 

headings.   

File     Setup    Protocol     Sequencer     Help 

 

 Clicking on any menu item opens a drop-down menu that lists the commands available 

under the selected heading.  A detailed description of each command is provided in Section 4.0 

Main Program 

 
Figure 2: 610A Main Window 

Located near the bottom of the main screen are a series of buttons labeled: Start Test, 

Start Sequence, Stop Test, Analysis and Instant Stim.  These buttons are used to start a test 

protocol, start a sequence of test protocols, stop a test protocol, open the Analysis window for 

basic analysis of the data acquired, and produce stimulation pulses at the click of a button, 

respectively.  Located near the top left of the window are two text readout boxes that display the 

current values of selected input channels.  Each of these text readouts can be set to show either: 

Length In, Force In, Aux 1, Aux 2, Aux 3, Aux 4, Aux 5 or Aux 6.  Below the channel readouts 

are two timers which show Elapsed Time since the program was started, and time since the last 
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test was completed.  The units for all channels are set using the Setup>Channel Setup menu.  At 

the bottom of the window is a box that displays status messages.  

3.4 Using the 610A DMC Program 

Now that that program is up and running we will go through the main steps required to 

set up an experiment, control a dual-mode lever system and take some data.  For this example we 

will assume that the user has a 300C dual-mode lever system.  If your instruments are different, 

simply substitute your actual model number in the instructions.   

 

Please note that if you are connecting the 610A Dynamic Muscle Control to a dual-mode 

lever system then you will be able to control and measure both length and force.  However, if 

you are using a separate force transducer and length controller then you will not be able to 

control force.  If you require this ability then please consider using our 600A software which can 

provide force feedback control when using a separate length controller and force transducer.   

 

Your instruments should be connected correctly to the 604A Signal Interface (if not, see 

section 3.1 in this manual).   If you are electrically stimulating the muscle tissue then ensure that 

the stimulator is also connected correctly.  It is recommended that while you are becoming 

familiar with the program you use an elastic (rubber) band instead of using muscle tissue.   

Quick Start Guide 

1) Turn on the PC, log in, and start the 610A program (Section 3.2 Turning on the PC and 

Using the Desktop). 

2) Click on Setup>My Instruments.  

3) Add your instruments to the list using the controls at the bottom of the My Instruments 

window. 

4) Select the instrument model using the pull-down menu, and then enter the serial number 

of the instrument to provide a unique identifier for it.  DMC is capable of storing 

configurations for multiple instruments. For instance, if you have both a 300C, and a 

305C, DMC can store the configurations and calibrations for both, and you can select 

which instrument you are using for a particular test.  Clicking Add Instrument will add 

the selected instrument to the list with the default calibration factors.  Note: you should 

still perform a proper calibration of your dual-mode system or your length controller and 

force transducer, but for now the default values will work fine.  If you want to perform a 

calibration then scroll the list so that the instrument you wish to calibrate is at the top of 

the list.  Click the calibrate button to the right of the instrument list.  If you are using 

instruments that are not listed on the pull-down selector (i.e., you have selected “Other”) 

then make sure you perform the calibration on them before proceeding to step 5) 

5) Click on Setup>Channel Setup.  

6) Using the pull-downs at the left set Length In, Length Out, Force In, and Force Out to the 

corresponding channels on your instrument.  Choose appropriate units and set the 

precision according to your preferences.  Good settings for a 300C are mm and mN, 3 

digits of precision in length, 1 digit in force.  Click Save Changes when done. 

7) If you’ve selected reference units on the Channel Setup then you must enter a Reference 

Force (Fmax) and Reference Length (Lo) in the boxes provided on the main window.  

Fmax is only required for plots of F/Fmax therefore if Fmax is not known you can enter 1 
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for now.  The Lo value is used for plotting length in terms of L/Lo but it can also be used 

in the test protocols for setting length.  Do not set the Reference Length or Reference 

Force to zero.  If in doubt set them both to 1. 

8) At this point the program is set up and you are ready to create a test protocol.  Click 

Protocol on the menu bar. 

9) The protocol editor window (Figure 3) allows the user to create a series of events based 

on time.  There are four headings on the screen labeled  

Wait(s)      Then (action)     On (port)     Parameters 

 

 
Figure 3: Protocol Editor Window 

10) Control buttons and text entry boxes are located near the centre of the screen.  Located at 

the bottom of the screen are text entry boxes to allow you to set the Input and Output 

Sampling Frequencies.  To the right of the text entry boxes are four buttons labeled: Open 

Protocol, Save Protocol, Load Protocol, and Close Window. 

11) For this example we will create a test protocol that will demonstrate length control, and 

electrical stimulus.  The protocol will stimulate the muscle and perform a length sine 

movement.  Enter the protocol shown in Figure 3 by entering the Wait (s), Then (action), 

On (port) and Parameters values in the central protocol edit section of the window.  If the 

row doesn’t exist then you can click Add Row first, enter the values and then click 

Commit Change or you can first enter the values and then simply click Add Row which 

will add the currently defined row and commit it in one step. 
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12) Information about the current action is displayed in the box near the bottom of the screen 

labeled Description of Function.  This text box provides a brief description of each 

function including the expected number of parameters, and what each parameter is.  A 

very important note about protocols is that while steps cannot overlap in time due to the 

nature of the protocol editor (you cannot cause a change in length and force at the same 

time), you can cause stimulation to occur during a length or force change.  This is done 

by issuing the Stimulation command before the length/force command and including an 

initial delay value in the stimulation command.  This delays the start of the stimulation by 

a set amount of time from when the command occurs in the protocol.  Test protocols can 

be of any length and can contain multiple occurrences of the same function if desired.  

13) Protocols must be saved before they can be loaded.  Press the Save Protocol button, enter 

an appropriate file name and then press the Load Protocol button which will load the 

protocol into memory and generate the samples for output.  The protocol is now ready for 

running. 

14) Before running the protocol you may want to start the Live Data Monitor.  The Live Data 

Monitor provides a real-time scrolling output on a separate window that resembles an 

oscilloscope or a strip-chart recorder.  It is very useful at providing a long-term record of 

what the input data channels are recording.  The main screen provides a numerical output 

of the current Lin and Fin.  This readout is useful to see what these values are at any 

given time but for slow trends (like monitoring resting tension) it is very useful to have 

the recording from the Live Data Monitor function.  Click on File>Live Data to open the 

Live Data Monitor window.  The Live Data Monitor runs independently of the main 

control and graphics section of the program and there is no concern that it will interfere 

with the main control program.  The Live Data Monitor collects data at a constant 100 

Hz.  See Section 5.0 Live Data Monitor for a more detailed description. 

15) Press the Start Test button on the bottom left side of the main screen to execute the 

protocol.  The protocol will start as soon as you press the button and as soon as it is 

complete the results will be graphed on the main screen.  For very short protocols the 

main plot appears so quickly that it seems to almost be plotting as the protocol 

progresses.  However, for long protocols you may want to view the results of the protocol 

as it occurs.  For this case use the Live Data Monitor to show test results as they are 

taken.     

16) When the protocol is complete the data can be saved by clicking on File>Save Data.  

Alternatively if the “Save on Test Completion” button is selected then a data save 

window will popup automatically at the conclusion of each test which will allow you to 

enter a data file name and location. 

17) The Analysis button can be used to review the stored data, zoom in on a selected area and 

perform calculations.  See chapter 6.0 for more details on using Analysis. 

18) The ASI610A program can be closed by clicking on File>Exit. 
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4.0 Main Program 

 The 610A Dynamic Muscle Control program uses a familiar Windows-type interface that 

consists of a main window containing a graphics window, control buttons, several text readouts 

and a series of drop-down menus.  The main window can be moved, re-sized, minimized, 

maximized and closed by clicking on the various window controls provided.  In the upper right 

corner of the window are minimize and maximize buttons.  Clicking anywhere on the window 

will bring the focus to the window.  The window can be dynamically re-sized by clicking on a 

border or a corner of the window.  Details of the main program window and program operation 

will be presented in the following sections. 

4.1 Main Screen 

 The main screen consists of a menu bar at the top, a large graphics window located in the 

centre, a number of text readouts and control buttons, and a status line at the bottom of the 

window, see Figure 4. 

 

 
Figure 4: 610A DMC Main Window 

4.1.1 Graphics Window 

 The graphics window is used to plot the length and force measured from the muscle 

tissue and to show stimulation.  The graph consists of time along the x-axis, force on the upper 

graph, length on the centre graph, and stimulus on the lower graph.  The input and output traces 

are plotted in different colours, red shows the protocol outputs and green shows the measured 

test data.  Yellow cursors are placed on the graph to denote the starting and ending points of each 
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stimulus command.  This allows you to easily line up your stimulus with a change in length, or 

force.  The stimulus signal is drawn as a solid red bar between the yellow cursors whenever the 

input data collection rate is less than 10 kHz. This bar shows the time interval when stimulus is 

occurring, the actual stimulation pattern is set by the protocol. When the data collection rate is 

set to 10 kHz there is sufficient resolution to display each individual stimulus pulse and thus the 

red bar is replaced with the individual stimulus pulses. 

 

The graphs are updated at the completion of each test protocol and also whenever the 

protocol is changed.  The relative size of each of the graphs can be changed by dragging the 

horizontal grey bars between the graphs to resize them and in the event the graph is sized larger 

than the available area a vertical scroll bar will appear on the right side of the graphing area.  The 

display units for length and force are set using Setup>Channel Setup.  The data shown is set by 

clicking the Show/Hide Protocol or Show/Hide Data buttons.  The time range of the data is 

controlled by using the sliders located below the graphs which is used to pan and zoom the 

window or you can use click-zoom by left clicking anywhere on the graph, dragging out a box 

and then releasing the mouse button, or by typing in the starting and ending times on the 

horizontal time axis (i.e., click on the 0.000 time label on the left of the time axis and type in a 

time, when you press enter the graph will automatically zoom to that time interval.   You can 

cause repeated zooms by click-zoom or using the cursor controls.  To return the data display to 

the entire test interval simply click the Unzoom button.  The program automatically scales the 

vertical axes to the range of the collected data.   

 

Further data analysis is provided through the Analysis button found near the bottom of 

the main window above the Instant Stim button.  The Analysis button opens an Analysis window 

where further data manipulation and calculations can be performed; please refer to chapter 6 for 

details.  There are two companion programs to DMC that provide many standard muscle 

physiology analysis routines.  These programs are Dynamic Muscle Analysis (DMA, model 

611A) and DMA High-Throughput (model 612A).  Please contact Aurora Scientific Inc. for 

further information about our analysis programs.  

4.1.2 Control Buttons 

 The main screen includes nine control buttons.  These are: Reset Timer, Log Comment, 

Show/Hide Protocol, Show/Hide Data, Start Test, Start Sequence, Stop Test, Analysis, Instant 

Stim and Unzoom (see Figure 4). 

Reset Timer Button 

The Reset Timer button is used to reset the Elapsed Time displayed directly above the 

button.  The timer displays elapsed time since the program was started, or since the last time you 

clicked the Reset Timer button.  You can use this timer to time the start of your protocols in 

relation to other experimental information. 

Log Comment Button 

The Log Comment button is used to place the contents of the Comments box into the log 

file.  DMC creates a unique log file each day that the program is started, and records information 

such as the time a protocol is started, what files are created, when protocols were loaded, etc. in 

this file.  The Log Comment button allows the user to enter their own comments into this file to 
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better annotate the specifics of a given experiment.  All comments are time stamped with the 

time when you pressed the Log Comment button. 

Show/Hide Protocol Button 

 This button turns the display of the protocol (shown in red) on or off on each of the 

graphs.  The protocol values are Lout, Fout and Stim out.  Since each plot automatically scales 

the vertical axis, turning off the protocol data often allows the test data to be viewed more 

clearly. 

Show/Hide Data 

 This button turns the display of the test data (shown in green) on or off on each of the 

graphs.  The test data values are Lin, Fin and Stim out.  Each plot is automatically scaled to the 

range of the displayed data.  In some cases it helps to turn off the test data if there is a need to 

observe the protocol. 

Start Test Button 

The Start Test button is used to start a test protocol running.  A protocol must exist 

(saved) and be loaded into memory (by the Load Protocol button in the protocol editor) before 

the Start Test button will operate.  Upon clicking the Start Test button the program will sequence 

through the test protocol performing the functions listed there.  Immediately following 

completion of the test the length and force results will be plotted on the graphics window.  If the 

Save on Test Completion checkbox is checked then the data will be automatically saved to a 

location specified. 

Start Sequence Button 

The Start Sequence button is used to start a sequence of test protocols.  A sequence must 

exist and be loaded into memory from the Load Sequence button in the Sequence Editor window 

before the Start Sequence button will operate.  Upon clicking the Start Sequence button the 

program will execute the first protocol then wait for the Next Test button to be pushed, or, if 

automatic timing is set, it will automatically advance to the next protocol after the defined time.  

Immediately following completion of each protocol in the sequence the length and force results 

will be plotted on the graphics window.   

Next Test Button 

The Next Test button is used to start the next protocol in a sequence.  The Next Test 

protocol will only become active after the Start Sequence button has been pressed and then only 

if the chosen sequence contains more than two protocols and the next protocol in the sequence is 

set to a manually timed step. The status line will indicate that it is waiting for the user to click 

Next Test to continue.  

Stop Test Button 

The Stop Test button is used to stop a test protocol or a sequence of test protocols.  The 

button freezes all control action of the program as soon as the button in pressed.  For example, if 

the length out is set to 1.5 mm when the Stop Test button is pressed then it will stay at this value.  

The graph presented on the main screen will show actual Length and Force signals up to the 

point at which the Stop Test button was pressed.  Think of this control as an emergency stop.  If 
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something goes wrong during your protocol or sequence, this button will stop all control actions 

including length, force and stimulation control. 

Analysis Button 

 The Analysis button is used to open the analysis window.  This window is used to 

examine the recorded data in greater detail, and perform simple analysis on it.  More information 

is listed in Chapter 6.  For more in-depth analysis, please use the Dynamic Muscle Analysis 

software. 

Instant Stim Button 

The Instant Stim button is used to control a stimulator when not running a protocol.  This 

is useful when setting up your electrodes, to perhaps find the location with the best response.  To 

activate stimulation you must first set up the stim parameters you require using the Setup>Instant 

Stim menu.  After starting Instant Stim the button changes to a red Stop button to allow you to 

abort a string of stimulation pulses.  The button is orange to remind you that this action can 

produce dangerous voltages at the stimulator output, and that you must use caution to ensure 

your safety. 

 

Unzoom 

 The Unzoom button is used to return the pan and zoom sliders to their default position to 

view the entire data file. 

4.1.3 Text Readout Boxes 

 Ten text boxes are located on the main screen.  Four of these provide text readout and the 

other six are for text entry.   

 

The top two boxes, shown as green numbers, provide the current values of the selected 

data input channels (you can define either box to show Force In, Length In, Aux1 – Aux 6).  

Normally these readouts will be set to monitor Force In and Length In.  Below these readouts are 

two timers showing Elapsed Time and Time Since Last Test. 

   

The next group of readouts includes the reference force and length (Ref Force and Ref 

Length) and the Offset Force and Offset Length.  The reference values can only be entered if the 

units are set to reference using Setup>Channel Setup.  The offset values are used to set the initial 

values of force and length at the start of a test.  

 

The comments box provides a simple method of adding user comments to your data files 

and to the daily log file kept by the program.  Text entered in the Comments box will 

automatically be saved into all data files when each test completes. Beneath the Comments box 

is a button labeled Log Comment, clicking this button will add the currently displayed text in the 

Comments box to the daily log file along with a time stamp. 

 

Near the bottom of the window is the Autosave Base text entry box.  This box allows the 

user to set the base filename used when the program automatically saves data.  When the Enable 

AutoSave checkbox is checked data files are automatically saved at the end of a test without the 

user being prompted for a file name.  To use the Autosave feature first set the folder where the 

data files will be stored by using the Setup>AutoSave Folder menu option.  Then set the base 
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filename by entering it in the AutoSave Base text entry box.  Each automatically saved data file 

will be saved into the specified folder with the base filename and a sequential number. 

4.1.4 Test Progress and Status Line 

 A test progress bar is provided at the bottom of the window which changes to a green line 

as the test progresses.  Below the progress bar is a status line that provides information about 

program operation. 

 

4.2 Main Menu 

 The main menu consists of the following six headings.   

File     Setup     Protocol     Sequencer     Help 

4.2.1 File Menu  

The File menu contains commands to save data files, open the Live Data Monitor, open 

the Log File folder, and exit the program.  

Save Current Data 

This menu item opens a Save As dialog box that allows the current data to be saved to 

disk.  Note: the data file is stored in ASCII format and the structure of the file is provided in 

Appendix A. 

Live Data Monitor 

This menu item opens the Live Data Monitor window; see Chapter 5 for more details. 

Open Log Folder 

This menu item uses Windows Explorer to open the folder where log files are stored. 

Exit 

This menu item closes the 610A DMC program. 

4.2.2 Setup Menu  

The Setup menu contains commands to manage and calibrate your instruments, set up the 

channel configuration and display units, set up Instant Stim, and Autosave features, and to enable 

or disable external triggers. 

4.2.2.1 My Instruments 

 The My Instruments menu item found under the Setup menu allows the user to setup and 

calibrate their instruments.  The My Instruments window, see Figure 5, is used to tell DMC what 

instruments you have, and what their calibration factors are.  Users can input as many 

instruments as they like including all instruments made by Aurora Scientific and any 3
rd

 party 

instruments.  My Instruments includes the factory settings for the calibration factors for all ASI 

instruments however 3
rd

 party instruments will need to be calibrated before their calibration 

factors can be shown.  As noted at the bottom of the My Instruments window, Channel Setup 
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must be complete before calibrating your instruments.  The Channel Setup window is covered 

later in this section. 

  

 To calibrate your instrument, scroll the desired instrument to the top of the list using the 

Up/Down arrow control found at the top left of the window.  Then click the button labeled 

Calibrate. 

Calibration Editor 

 The Calibration Editor is used to calibrate instruments.  There are three forms of the 

calibration editor that are used for calibrating length in, force in and force out.   

Calibrating Length 
 When operating a Length Controller (either a Dual-Mode Lever System, or a High-Speed 

Length Controller) both Length In and Length Out must be calibrated. Please note: all references 

to In/Out are relative to the PC. This is different from past versions of DMC where In/Out was 

relative to the instrument being controlled.   For example, “Length Out” in the software is the 

command signal sent to an instrument and corresponds to “Length Out” on the 604A Signal 

Interface which is connected to “Length In” on a length controller. 

 
Figure 5: My Instruments Window 

The leftmost panel on the calibration window, see Figure 6, is used to calibrate Length In 

and Length Out. The text entry boxes in the 'Volts' column are used to set the output voltage to 

levels which are close to the values we might expect to see in normal use. It is a best practice to 

set the calibration voltages to be equally spaced throughout the anticipated travel of the 

instrument, however this is not imperative. Note: one of the calibration output voltages MUST be 

set to zero (0) volts.  
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Figure 6: Calibration Editor Shown Calibrating a 300C 

Enter seven calibration voltages and then click a button in the ‘Set’ column next to a 

calibration voltage. Normally you would start with the line that contains the zero calibration 

voltage and then change to each of the other lines.  When you click the Set button the Length Out 

is set to the calibration voltage you entered.  Next click the Read button on the same row. The 

Read button causes 100ms of data to be collected from Length In and then an average value is 

calculated and the result is placed in the Measured Voltage text box.  You must now measure the 

actual movement of the lever arm and enter this amount in the Movement (mm) text box on the 

same line. Repeat this for all 7 lines.  

 

Once you have completed the table, the buttons at the bottom of the panel will become 

active.  Click the Calculate Cal Factors button to populate the LIn Scale, and LOut Scale text 

boxes located at the bottom of the window. These values are calculated from a Least Squares fit 

of the calibration data. Note: the scale factors are in mm/volt. The values should be close to the 

factory defaults for the instrument. If they aren't, then redo the calibration ensuring that you 

make accurate measurements of the arm movement. 

 

After the calibration factors are calculated, the calibration data and curve fit can be 

plotted by clicking on the Plot LI Cal (Length In calibration plot) and Plot LO Cal (Length Out 

calibration plot) buttons.  

Calibrating Inputs – Force In/Temp In/3
rd

 Party In 

 

Calibration is required for all instruments that provide an input to the DMC program.  

This section of the manual deals with the calibration of all input channels, except for the Length 

In channel from a Dual-Mode Lever System. Please note: all references to In/Out are relative to 

the PC. This is different from past versions of DMC where In/Out was relative to the instrument 
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being controlled.   For example, “Force Out” in the software corresponds to “Force Out” on the 

604A Signal Interface, and gets connected to “Force In” on a 300C. 

Force In Calibration of Dual-Mode Lever Systems 

Click the "Set Max Force" button located above the Force In section of the window.  This 

sets the force on the dual-mode system to its maximum, allowing input forces to be measured 

properly. Position the dual-mode force/length transducer such that the lever arm is horizontal and 

then hang a weight from the lever arm using an elastic (rubber) band.  Now use the controls in 

the leftmost column of the Force In section to enter the applied force (measured in grams) of the 

weight hanging from the lever arm. The measured points do not need to be equally spaced in 

order to calculate a usable calibration factor, however, it is recommended that you space them as 

evenly across the full range as is possible.  Click the Read button on the same row which records 

100ms of data, calculates an average and then places the result in the field labeled Measured 

Voltage. Repeat this for the 7 rows in the table. Click the Calculate Cal Factor button to populate 

the Fin Scale text box located at the bottom of the window.  This value is the calculated Least 

Squares fit of the calibration data.  The Force In scale factor is in mN/volt. The value should be 

close to the factory default for the instrument. If it isn't then redo the calibration ensuring that 

you input accurate values for the applied force.   

 

After the calibration factors are calculated, the calibration data and curve fit can be 

plotted by clicking on the Plot Cal button. 

ASI Force Transducers 

Locate the force transducer such that the output tube is vertical and pointing down and 

then hang a weight from the tube (fashion a small hook from wire and attach the wire to the 

output tube if required).  Now use the controls in the leftmost column of the Force In section to 

enter the applied force (measured in grams) of the weight hanging from the tube. The measured 

points do not need to be equally spaced in order to calculate a usable calibration factor, however, 

it is recommended that you space them as evenly across the full range as is possible.  Click the 

Read button on the same row which records 100ms of data, calculates an average and then places 

the result in the field labeled Measured Voltage. Repeat this for the 7 rows in the table. Click the 

Calculate Cal Factor button to populate the Fin Scale text box located at the bottom of the 

window.  This value is the calculated Least Squares fit of the calibration data.  The Force In scale 

factor is in mN/volt. The value should be close to the factory default for the instrument. If it isn't 

then redo the calibration ensuring that you input accurate values for the applied force.   

 

After the calibration factors are calculated, the calibration data and curve fit can be 

plotted by clicking on the Plot Cal button. 

ASI 825A TEC Controllers 

When calibrating a TEC controller the text in the central calibration area of the screen 

will change from force to temperature.  Use the controls in the leftmost column to enter the 

applied temperature in degrees centigrade. The measured points do not need to be equally spaced 

in order to calculate a usable calibration factor, however, it is recommended that you space them 

as evenly across the full range as is possible.  Click the Read button on the same row which 

records 100ms of data, calculates an average and then places the result in the field labeled 

Measured Voltage. Repeat this for the 7 rows in the table. Click the Calculate Cal Factor button 
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to populate the calibration scale factor text box located at the bottom of the window.  This value 

is the calculated Least Squares fit of the calibration data.  The temperature scale factor is ⁰C/volt. 

The value should be close to the factory default for the instrument. If it isn't, then redo the 

calibration ensuring that you input accurate values for the applied temperature.   

 

After the calibration factors are calculated, the calibration data and curve fit can be 

plotted by clicking on the Plot Cal button. 

3
rd

 Party Instruments 

DMC can be used with third party instruments that have a +/-10V analog output with 

linear scaling.  Use the controls in the leftmost column of the central calibration area to enter the 

applied signal in the units of the 3
rd

 party device.  The measured points do not need to be equally 

spaced in order to calculate a usable calibration factor, however, it is recommended that you 

space them as evenly across the full range as is possible.  Click the Read button on the same row 

which records 100ms of data, calculates an average and then places the result in the field labeled 

Measured Voltage. Repeat this for the 7 rows in the table. Click the Calculate Cal Factor button 

to populate the Scale text box located at the bottom of the window.  This value is the calculated 

Least Squares fit of the calibration data.  The scale factor is in the units of the 3
rd

 party 

instrument/volt.  

 

After the calibration factors are calculated, the calibration data and curve fit can be 

plotted by clicking on the Plot Cal button.  

Calibrating Force Out 

 This calibration only applies to Dual-Mode Lever Systems.  The force output is calibrated 

using the rightmost panel on the calibration window. Please note: all references to In/Out are 

relative to the PC. This is different from past versions of DMC where In/Out was relative to the 

instrument being controlled.   For example, “Force Out” in the software corresponds to “Force 

Out” on the 604A Signal Interface, and gets connected to “Force In” on a 300C. 

 

Note: Before calibrating Force Out the Force In calibration procedure shown above must be 

completed. 

 

The text entry boxes in the 'Volts' column are used to set the output voltage to levels to 

the force controller.  Select values that are expected to be seen in normal use. It is a best practice 

to set the calibration voltages to be equally spaced throughout the anticipated force range of the 

instrument, however this is not imperative. Note: one of the calibration output voltages should be 

set to zero (0) volts.  

 

Enter seven calibration voltages and then click a button in the ‘Set’ column next to a 

calibration voltage. Normally you would start with the line that contains the zero calibration 

voltage and then change to each of the other lines.  When you click the Set button the Force Out 

is set to the calibration voltage you entered.  At this point, you must apply enough force to the 

lever arm to place the system into force-control mode, but you must not apply so much force as 

to drive the system into fault.  Gently apply increasing pressure to the lever arm until the reading 

on the Force Out meter located on the front panel of the dual-mode system stops changing, and 

the arm starts to move.  Hold the arm in this position, and click the “Read” button on the same 
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row.  The Read button causes 100ms of data to be collected from Force In and then an average 

value is calculated and the result is placed in the Measured Voltage text box.  Repeat this for all 

7 lines.  

 

Once you have completed the table, the buttons at the bottom of the panel will become 

active.  Click the Calculate Cal Factors button to populate the FIn Scale text box located at the 

bottom of the window. The value is calculated from a Least Squares fit of the calibration data. 

Note: the scale factors are in mN/volt. The values should be close to the factory defaults for the 

instrument. If they aren't, then redo the calibration ensuring that the lever arm is in force control 

mode before pressing the Read button. 

 

After the calibration factors are calculated, the calibration data and curve fit can be 

plotted by clicking on the Plot Cal button.  

4.2.2.2 Channel Setup 

The channel setup window is used to configure the input channels for each individual 

instrument connected to the PC.  This configuration involves selecting the instrument/channel 

from My Instruments that is connected to each of the physical channels on the 604A Signal 

Interface. 

Upon opening this window (Figure 7), the controls are populated with the instruments 

currently stored in My Instruments. The calibration constants for the selected device and channel 

will automatically populate when you select a connected device, using the leftmost drop down 

controls.  

 
Figure 7: Channel Setup Window 
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The option 'Stim Monitor' is typically used on channel Aux 1 to monitor the stimulator 

output from DMC. This is done by connecting a BNC T to the Stimulator Output, and running a 

BNC cable from there to Aux 1, and from the T to the stimulator. This allows DMC to record the 

actual stimulation pulses that went out.  Alternatively you can connect the Sync Out from a 701C 

stimulator to Aux 1.   

For devices that measure in base units of either mm, or mN, DMC will allow you to 

display the data in several different units (e.g., µm, cm, N, gm). For devices that measure in 

other units, such as °C, DMC will ONLY allow you to display in terms of the base unit.  

DMC also offers torque and angle units for displaying the data from the sensors, but you 

must provide DMC with the appropriate Torque Application Distance. This is the distance from 

the point of torque application, to the centre of the motor shaft.  The program knows the default 

Torque Application Distances for all ASI 300C series instruments and will automatically 

populated these fields when selecting torque and angle units.  The user can overwrite these if 

they are using modified ASI lever arms. 

Additionally, DMC allows you to display data in terms of Reference units, such as Lo 

and Fmax. To do this, change the display unit to Ref, and click Save Changes. Then, on the main 

panel of DMC, enter the reference length and reference force, in terms of mm or mN.   

NOTE: if you wish to control outputs in terms of reference units, that you MUST re-load the 

protocol any time you make a change to the reference length or force. This is because DMC 

generates the entire protocol when you load it, and when you change the reference values the 

program must regenerate the protocol with the new values.  

The DISPLAY units of Length Out and Force Out are the units that the protocol is 

calculated with.  You must choose the same units for Length In/Length Out, and Force In/Force 

Out in order to ensure proper display of the graphs.  The program enforces this by automatically 

changing the linked unit when you change the display units for one of the paired channels. 

4.2.2.3 Setup Instant Stim 

 The Setup Instant Stim window (see Figure 8) is used to set up the Instant Stim feature.  

The parameters are essentially the same as those in the protocol editor, and describe the pulse 

train that will come out.  The settings shown in Figure 8 will result in a single 0.5ms pulse.  You 

can change these settings to match any stimulation parameters you require, including longer 

pulses, shorter pulses (pulse width must be between 0.1and 10.0 ms), multiple pulses, pulse 

trains or a single burst of pulses.  Once the parameters are set using this menu, the Instant Stim 

button on the front panel becomes active. 
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Figure 8: Instant Stim Setup 

 

4.2.2.4 Enable Input Triggers 

 This menu option Enables/Disables the external Start Test and Start Sequence triggers.  

You can use a TTL signal from an outside instrument to trigger DMC to start a protocol or to 

start a sequence.  The ports labeled “Trg In 1” and “Trg In 2” on the 604A signal interface are 

used as the input triggers for Start Test and Start Sequence respectively.   

4.2.2.5 AutoSave Folder 

 This menu option brings up a Save As window.  Navigate to the folder you wish to auto-

save into, and then click on the Current Folder button.  Once you have selected a folder to store 

data files in then you can check the Enable AutoSave checkbox on the main window. 
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 4.2.3 Protocol Editor 

Clicking on the Protocol menu option brings up the Protocol Editor window.  Using the 

Protocol Editor, a user can create, edit, and load protocols into the software. 

 

Test protocols are the heart of the control system and they provide all the functions 

necessary to generate any muscle physiology test desired.  The Protocol Editor screen can be 

divided into the following four sections: a) the top portion of the screen displays the test 

protocol, b) the middle section allows the user to edit selected lines of the protocol, c) a text 

section is below the editing section and it displays information about the selected function and, 

d) at the bottom the Sampling Rates are set and control buttons are provided.  

 

 
Figure 9: Protocol Editor 

All test protocols are listed in order of steps.  Each step includes a Wait time, a function 

and its port and function parameters.  A step cannot start before a previous step has completed.   

Length, Force, and Trigger steps must complete before another Length or Force step can start.  

Stimulus functions can be delayed so that they happen after the start of the next step. 

 

The following is a list of all available functions including a brief description, a list of the 

required parameters for the function and an example of the function’s usage.  The examples are 

all shown as a wait time followed by the function name, channel, and parameters. 
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4.2.3.1 Protocol Functions 

Step 

Description: Perform a step change in the output channel selected to the specified 

value. 

Parameters (1): value to step to (channel display units) 

e.g.: 0.5 Step Length Out 1  

Ramp 

Description: Perform a ramp change in the output channel selected to the specified 

value, over a specified time. 

Parameters (2): Value to ramp to (channel display units), Time (s) 

e.g.: 0.5 Ramp Length Out 1.0, 2.5  

Sine Wave 

Description: Generate a sine wave on the selected output port. 

Parameters (3): Frequency (Hz), Amplitude (channel display units), Number of 

Cycles 

e.g.: 0.5  Sine Wave Length Out 100, 5.0, 2 

Sum-Sine Wave 

Description: Generate a sine wave on the selected output port, which is the sum of 2 

sine waves 

Parameters (5): Frequency 1 (Hz), Amplitude 1 (channel display units), Frequency 2 

(Hz), Amplitude 2, Time (s) 

e.g.: 0.5 Sum-Sine Wave Length Out 100, 5, 10, 0.5, 2.5 

Stimulus-Train 

Description: Issues a train stimulation profile.   

Parameters (5): Initial Delay (s), Pulse Frequency (Hz), Pulse Width (ms), Pulses Per 

Train, Train Frequency (Hz) Note: zero entry for pulses per train results in a 

continuous stream of pulses. 

e.g.: 0.5 Stimulus-Train  Stimulator 0.7, 100, 0.2, 5, 1   

Stimulus-Tetanus 

Description: Issues a tetanus stimulation profile.   

Parameters (4): Initial Delay (s), Pulse Frequency (Hz), Pulse Width (ms), Duration 

(s)  

e.g.: 0.5 Stimulus-Tetanus  Stimulator 0.7, 100, 0.2, 1   

Stimulus-Twitch 

Description: Issues a twitch stimulation profile.   

Parameters (2): Initial Delay (s), Pulse Width (ms) 

e.g.: 0.5 Stimulus-Twitch  Stimulator 0.7, 0.2   

Trigger 

Description: Issues an output trigger. 

Parameters (1): Trigger setting 
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Trigger Setting Values: 0 = All off, 1 = Trig Out 1 on, 2 = Trig Out 2 on, 3 = Both 1 

and 2 on, 4 = 604B Switch 

e.g.: 0.5 Trigger Length Out 3 

Stop 

Description: Use this function at the end of a protocol to allow data collection to 

continue for the wait time associated with the Stop function.   

Parameters (0): None 

e.g.: 1.0 Stop 

4.2.3.2 Example Protocol 

As an example we will create a test protocol that will demonstrate length control and 

electrical stimulus.  The protocol will stimulate the muscle, perform a length sine movement, and 

continue to record data until the Stop command is processed. The protocol is shown in Figure 9. 

 

Note the help text that is displayed in the box near the bottom of the screen.  This text 

box provides a brief description of each function including the expected number of parameters, 

and what each parameter is.  A very important note about protocols is that while steps cannot 

overlap in time due to the nature of the protocol editor (you cannot cause a change in length and 

force at the same time), you can cause stimulation to occur during a length change.  This is done 

by setting an initial delay time in the Stimulation command.  This delays the start of the 

stimulation by a set amount of time from when the command occurs in the protocol.  Test 

protocols can be of any length and can contain multiple occurrences of the same function if 

desired.  

Stimulus Functions 

Stimulus functions are special because they include a delay time. The delay time is 

included to allow a stimulus to start after the start of a length or force command.  Since a step 

cannot start before the end of a previous step and because stimulation usually starts during a 

length or force function we have included the delay time to get around this limitation.  Normally 

the user would specify the stimulus function and set the delay time so that the stimulus occurred 

during the following function.  Three stimulus functions exist to make it easier for the user to 

define the profile required.  These functions are: Stimulus-Train, Stimulus-Tetanus and 

Stimulus-Twitch. 

 

The Stimulus functions use between 2 and 5 parameters to specify the function.  The 

parameters for Stimulus-Train are: Initial Delay, Pulse Frequency, Pulse Width, Pulses per Train, 

and Train Frequency.  The parameters for Stimulus-Tetanus are: Initial Delay, Pulse Frequency, 

Pulse Width and Duration.  The parameters for Stimulus-Twitch are: Initial Delay and Pulse 

Width. 

 

Initial Delay is the length of time between the command being issued, and the first 

stimulus pulse.  Use this to precisely control the placement of your stimulus in the commands to 

follow. 
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Pulse Frequency is the rate at which the individual pulses occur.  This parameter sets the 

start of each individual pulse (in the example Pulse Frequency is set to 100 Hz or one pulse every 

10 ms).    

 

Pulse Width is the width of each individual stimulation pulse.  In our example each pulse 

is 0.2 ms wide.   

 

Duration is the length of time (s) that a Stimulus-Tetanus will be active for.   

 

 Pulses per Train is the number of pulses in each burst of pulses.  If you are pacing 

cardiac tissue, then you would use this to set the number of pulses in each group.  If you do not 

require periodic bursts of pulses then use Stimulus-Tetanus or Stimulus-Twitch.   

 

Train Frequency is the rate at which the pulse trains get repeated.  In the example Train 

Frequency is set to 0.1 Hz or a train starting every 10 s.  If you wish to only receive a single 

group of pulses, then set this value to a sufficiently low number that the first repeat would 

happen AFTER the end of your test or use either the Stimulus-Tetanus or Stimulus-Twitch 

function. 

Editing 

When editing or creating a protocol note the step is not updated until the user clicks on 

the parameter box and then clicks the Commit Changes button.  If you are satisfied with the 

protocol and there are no errors press Save Protocol to save the protocol to disk.  Please note that 

a protocol MUST be saved before it can be loaded and run.  If you press the Close Window 

button before saving the protocol then all changes will be lost.   

Sampling Frequency 

The protocol editor also includes two controls to set the sampling frequency for data 

collection.  The Input Sample Frequency sets the data collection rate while the Output Sample 

Frequency sets the rate at which commands are sent to the instrument.  If you are noticing that 

your data looks like a staircase, instead of a smooth curve, then use a higher input and output 

sampling frequencies.  The accepted range for both input and output is from 100 Hz to 10 kHz. 

Open Protocol 

 This button opens a previously saved protocol file for editing. 

Save Protocol 

 This button saves a protocol file.  The file is stored in ASCII format and the file structure 

is provided in Appendix A. 

Load Protocol 

 This button loads a protocol file into memory and generates the output control data.  This 

must occur before a test can be run. 
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Unitized/Muscle % 

 This radio button is located on the upper right side of the window and it controls whether 

the protocol is unitized (uses units specified in Setup>Channel Setup), or is in terms of Muscle % 

(reference units expressed as percentages of Lo and Fmax). 

 

4.2.4 Sequence Editor  

The Sequencer button on the menu opens the Sequence Editor.  The Sequence Editor 

allows the user to create and edit sequences which are a collection of protocols.  The Sequence 

Editor looks and feels very much like the protocol editor.  It also works in much the same way.   

   

The Sequence Editor window can be divided into the following three sections: a) the top 

portion of the screen displays the table describing the sequence, b) the middle section allows the 

user to enter a base file name, select protocols and their corresponding file markers, and set that 

protocols parameters in a sequence, and c) four control buttons are provided below the editing 

section 

 
Figure 10: Sequence Editor Window 

Example Sequence 

 Figure 10 provides a sample sequence consisting of a tetanic and two twitch protocols 

that run one after another. 

 

 The first step is to enter the names of the protocols to be included in the sequence.  

Protocol file names can be typed into the box provided or the Browse button can be used to open 

a file dialog window.  It is more convenient to simply press the Browse button; highlight the 
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desired protocol and press OK to select the protocol and automatically enter it in the sequence 

line (see Figure 11 for an example of protocol file selection using the Browse button.) 

 

The Data File Name that will be used for storing the data from each protocol in the 

sequence is created from several parts.  Most of these parts are user-configurable.  The first 

portion, the file path, is set using the AutoSave Folder.  This is set in the Setup menu on the main 

window of DMC.  The next part of the file name is the Base Filename. This is set on a per-

sequence basis, using the Base Filename control in the middle of the Sequence Editor.  After this 

comes the File Marker section.  This is set on a per-protocol basis.  Each protocol in the 

sequence must have a unique File Marker.  The final section of the data file names comes from 

the run number.  Each time you run the sequence, this number will increment.    

 

 An unlimited number of protocols can be defined in a sequence.  A sequence can also 

repeat a given protocol as many times as required.  An example of this would be an experiment 

that used a pre-conditioning protocol followed by a test protocol and then followed by the same 

pre-conditioning protocol again, etc.  Ensure that you use unique file markers for each instance 

of the pre-conditioning protocol. 

 
Figure 11: Select Protocol File Window   

  Once you are satisfied with the sequence you must save the sequence using the 

Save Sequence button. 

Buttons 

Open Sequence 

 Opens a previously saved sequence file. 
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Save Sequence 

 Saves a sequencer file.  The file is stored in ASCII format and the file structure is 

provided in Appendix A. 

Load Sequence 

 Loads a sequence into memory.  As we are not using a real-time operating system, we 

must pre-generate the output data streams before we can run a test.  Clicking Load Sequence will 

enable the “Start Sequence” button on the Main Window. 

 

4.2.5 Help Menu  

The Help menu contains two commands: Topics, and About. 

Topics 

Opens the 610A help file.  Links are included in the document. 

About 

 Provides information about the ASI610A program including contact information for 

Aurora Scientific Inc. and the program’s version number. 
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5.0 Live Data Monitor 

 The Live Data Monitor provides a real-time output of length and force in a separate 

window.  A data buffer is provided that allows the user to review the Length and Force inputs 

over the past 30 minutes.  However Live Data Monitor can only show data for times when the 

window was open, if the window is closed then no data is buffered for display in the window.   

 

 Live Data Monitor includes controls to set the scale of the graph, the time base, and 

controls to freeze the display and scroll the display back and forth in time.  Data is always 

sampled at 100 Hz so trends that take place over time show very well.  However, because of the 

low sampling rate, short duration events are not displayed correctly. The window also includes 

another set of Start Test, Start Sequence, and Instant Stim buttons, to provide the flexibility to 

control tests from the Live Data Monitor window. 

 

 
Figure 12: Live Data Monitor Window 

To Use Live Data Monitor 

1) Start the 610A DMC program. 

2) Select File->Live Data Monitor. 

3) The Live Data Monitor window will open and data will start to be shown on the screen. 

4) Select Time Base to choose the amount of data shown on the screen.  The time base can 

vary from 10s to 30 min. 

5) Click the Autoscale checkboxes to enable/disable auto scaling of the displayed data.  

Disabling Autoscale allows you to set the vertical limits of the length and force graphs 

manually. 
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6) Use the Pause Data Display button to pause the scrolling of data.  Once the display is 

paused you can then use the left or right arrow buttons to scroll through all data measured 

in the past 30 minutes.  

5.1 Onscreen Controls 

Start Test 

 Begins the currently loaded protocol. This button performs identically behaviour to the 

Start Test button on the main screen. See Section 4.1.2 Control Buttons for details.  

Start Sequence 

 Begins the currently loaded sequence of protocols. This button performs identically to the 

Start Sequence button on the main screen. See Section 4.1.2 Control Buttons for details. 

Instant Stim 

 Sends the stim pulse currently set in the Instant Stim window. This button performs 

identically to the Instant Stim button on the main screen. See Section 4.1.2 Control Buttons for 

details. 

Close Window 

 Closes the Live Data Monitor Window 

Pause/Resume Data Display  

 This button pauses and resumes the update of the Live Data graph. When the Live Data 

Monitor is paused the scroll bar can then be used to review previous data. Data continues to be 

recorded in the background even when the display is paused.  When the Resume Data Display 

button is pressed the display will update to show the most recent data.  

Timebase 

 Data is graphed for a set span of time set by the Timebase drop down menu. Older data is 

viewable by clicking Pause Data Display and using the scroll bar at the bottom to scroll through 

previous data. 

Scale Controls  

 Each channel can be scaled individually by setting the Min and Max settings. Min is the 

value on the y-axis at the bottom of the screen, max is the value at the top. All data is plotted on 

this scale. Scale Controls can only be used if Autoscale is unchecked. 

Autoscale 

 The Autoscale checkbox controls whether the auto scaling function is active or not.  Two 

Autoscale controls are provided, one for the Force display and the other for the Position display. 

This function automatically sets the minimum and maximum values on the graph to optimize the 

display of all the data in the current Timebase shown. The scaling changes dynamically as new 

data is plotted and old data is pushed off the graph. 
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Find Scale  

 Automatically updates the Min/Max values to optimize the display of all the data in the 

current Timebase. This will not dynamically update like Autoscale does. Find Scale can only be 

used if Autoscale is unchecked. 
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6.0 Analysis 

 The analysis section of the program provides a limited set of analysis, graphics and 

storage functions.  A far more exhaustive analysis capability is provided with our Dynamic 

Muscle Analysis (DMA) program and its companion program DMA High-Throughput (DMA-

HT) which provides high speed, automatic data analysis. 

 

Open the Analysis window by clicking the Analysis menu item in the menu bar at the top 

of the main screen.  The Analysis window will appear as in Figure 13 and includes controls to 

turn on/off data and protocol plotting and to set the time base of interest.  A number of text boxes 

are provided at the bottom of the window which shows maximum and minimum force and length 

along with time to these maxima and minima.  A pull-down menu is provided at the top of the 

window that is used to select the data to be displayed.  In the case of data output from a sequence 

this control allows you to look back through all the protocols that were executed during the 

sequence.  All of these controls are discussed in detail in the following sections. 

6.1 Onscreen Controls 

 Directly beneath the graphics area are a series of controls that adjust settings on the 

Analysis window.  

Enable Sliders Checkbox 

 This checkbox turns the sliders on or off.  When the sliders are off, the graph displays the 

whole test, and when the sliders are turned on, the graph displays the selected portion of the test. 

Reset Sliders Radio Button 

 This button will reset the sliders back to viewing the whole test.  This allows the user to 

quickly reset the plotted time scale.   

Time Displayed (% Test Length) 

 This slider controls, as a percentage of the entire test, how much data is displayed on the 

screen.  Click on the inverted triangle shown on the slider and drag it to the left or right to 

control the time displayed. 

Offset (% Test Length) 

 This slider controls, as a percentage of the entire test, the starting time shown at the left 

side of the graphics screen.  Click on the inverted triangle shown on the slider and drag it to the 

left or right to control the start time of the displayed data. 

Show/Hide Protocol Button 

 This button turns the display of the protocol (shown in red) on or off on each of the 

graphs.  The protocol values are Lout, Fout and Stim out.  Since each plot automatically scales 

the vertical axis, turning off the protocol data often allows the test data to be viewed more 

clearly. 
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Click Zoom 

A click zoom function is included with Analysis.  Simple left click, drag out a box the 

size of the desired zoom and release the mouse button.  The graph will automatically zoom to the 

time interval outlined by the click zoom box. 

Show/Hide Data 

 This button turns the display of the test data (shown in green) on or off on each of the 

graphs.  The test data values are Lin, Fin and Stim out.  Each plot is automatically scaled to the 

range of the displayed data.  In some cases it helps to turn off the test data if there is a need to 

observe the protocol data. 

 
Figure 13: Analysis Window 

File Pull-down 

 The File Pull-down is located at the top of the window and it provides a pull-down list of 

the files included in a test sequence.  Any file in the protocol can be selected and then viewed. 

Load Data 

The Load Data button is located at the bottom of the window and it opens a file dialog 

window which allows a data file to be loaded and analyzed. 
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Close Window 

 The Close Window button is located at the bottom of the window and closes the Analysis 

window. 
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7.0 Installation of a New Version of the 610A DMC Program 

 This chapter provides a brief description of the procedure required to update to a newer 

version of the 610A program.   

 

Aurora Scientific Inc. is striving to make 610A the best program for the control of, and 

data acquisition from, muscle mechanics experiments.  We are pleased to receive user comments 

about the program and suggestions for new functions.  

 

New versions of 610A are available from our website at 

http://www.aurorascientific.com/update/.   

 

Once you have received a new version of the program please follow the procedure listed 

below to update your program.  

 

1. Close all open programs. 

2. Copy the supplied update file to the PC to be updated 

3. Run the setup.exe file found in the update package.   

4. Follow the on-screen directions to complete the installation process. 

5. You may be asked to reboot the computer upon completion.  Do so if requested. 

 

This completes the update procedure.  In order to check that the update has been installed 

correctly start the program and click on Help>About.  Compare the version number listed on the 

About screen with that shown in the update file name.  If they are the same then you have 

successfully updated to the latest program version.  If you experience any difficulties while 

updating your system please contact Aurora Scientific Inc. 

 

 

 

 

http://www.aurorascientific.com/update/
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8.0 Technical Support, Warranty and Repairs 

Aurora Scientific Inc. is dedicated to providing you with products that allow you to meet 

your research goals.  For this reason technical assistance is always free and will be available for the 

life of your product.  If you do have a problem with a product then please know that all ASI 

products are covered by a three year warranty covering both parts and labour.  If you need to return 

a product to us for repair then consult the final section of this chapter for returns information. 

8.1 Technical Support  

 Please don’t hesitate to contact us if you have any technical support issues.  Contact us by 

telephone, email, fax, or regular mail.   

 

 Address: Aurora Scientific Inc. 

   Technical Support 

   P.O. Box 2724 

   Richmond Hill, Ontario, CANADA 

   L4E 1A7 

 

 Phone:  1 905 727-5161 

 Toll Free: 1 877 878-4784 (North America) 

 FAX:  1 905 713-6882 

 E-mail:  TechSupport@AuroraScientific.com 

 Web site: www.AuroraScientific.com 

8.2 Warranty 

 Products manufactured by Aurora Scientific Inc. (ASI) are guaranteed to the original 

purchaser for a period of three (3) years.  Under this warranty, the liability of ASI is limited to 

servicing, adjusting and replacing any defective parts that are of ASI manufacture.  ASI is not liable 

to the customer for consequential or other damages, labour losses or expenses in connection with or 

by reason of the use or inability to use the products manufactured by ASI.   

 

 Guarantee of parts and components not manufactured by ASI shall be the same as the 

guarantee extended by the manufacturer of such components or parts.  Where possible such parts 

returned to ASI will be sent to the manufacturer for credit or replacement.  Ultimate disposition of 

these items will depend upon the manufacturer's decision.   

 

 All shortages must be reported within ten (10) days after receipt of shipment. 

 

 Except where deviations are specified in literature describing particular products, the limited 

warranty above is applicable to all ASI products, provided the products are returned to ASI and are 

demonstrated to the satisfaction of ASI to be defective. 

 

 Transportation costs of all products returned to ASI must be borne by the customer and 

products must be returned to ASI within three years after delivery to the original purchaser.  ASI 

http://www.aurorascientific.com/contact/
http://www.aurorascientific.com/contact/
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cannot assume responsibility for repairs or changes not authorized by ASI or damage resulting from 

abnormal or misuse or lack of proper maintenance. 

 

 Repair or service work not covered under the limited warranty will be billed at current 

service rates.   

 

NO EXPRESS WARRANTIES AND NO IMPLIED WARRANTIES WHETHER FOR 

MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE, OR OTHERWISE 

OTHER THAN THOSE EXPRESSLY SET FORTH ABOVE WHICH ARE MADE 

EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, SHALL APPLY TO PRODUCTS 

SOLD BY ASI, AND NO WAIVER, ALTERATION OR MODIFICATION OF THE 

FOREGOING CONDITIONS SHALL BE VALID UNLESS MADE IN WRITING AND 

SIGNED BY AN EXECUTIVE OFFICER OF ASI. 

8.3 Returning Products to Aurora Scientific Inc. for Repair  

There are a few simple steps that must be completed before returning your product to 

Aurora Scientific Inc. 

 

1. Obtain a Return Material Authorization number (RMA#). 

Contact our technical support department to obtain a RMA #.  We require the serial number 

of the product along with your contact information, i.e. your name, institution, phone 

number and email address. 

 

2. Package your instrument. 

Use the original packaging materials if available. If you do not have original packaging then 

ensure that the product is wrapped in bubble pack and placed in a sturdy corrugated 

cardboard box. If you are returning a force transducer please place the transducer head in the 

plastic protective box and then wrap the plastic box in bubble pack and place it in a small 

cardboard box which can then be placed in the larger box along with the electronics. For 

force transducer repairs we require both the transducer head and the control electronics. 

Please don't send the power cord. When returning a muscle lever system wrap the motor in 

bubble pack and place it along with the lever arm in a small cardboard box and then place 

that box in the larger shipping container along with the controller. For muscle lever repairs 

we require the motor, lever arm, motor cable and control electronics. Please don't send the 

power cord. 

 

3. Prepare Customs documents. 

Canadian Clients: no customs documents are required, skip to step 4. 

European Clients: no customs documents are required, skip to step 4 and ship to Aurora 

Scientific Europe. 

USA and Rest of the World Clients: You must include a Commercial Invoice (CI) with 

the shipment. Please click this link to download a blank CI. 

You can also prepare the commercial invoice yourself instead of using the downloadable 

form. Print the document on your company's letterhead and include the following 

information: Date, Shipper's Name, Address and Phone Number (your company 

information), Consignee's Name, Address and Phone Number (Aurora Scientific Inc. is the 

http://www.aurorascientific.com/
http://www.aurorascientific.com/
mailto:TechSupport@AuroraScientific.com?app=LeadgenDownload&shortpath=docs/CCI.pdf
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Consignee), Country of Origin of Goods (this will be Canada if you purchased the 

instrument from Aurora Scientific or USA if your product was purchased from Cambridge 

Technology), Conditions of Sale (include the following statement: GOODS RETURNING 

TO FACTORY FOR REPAIR, TEMPORARY IMPORT), Number of Packages (normally 

1), Description of Goods (e.g. Model 300B Muscle Lever System, Serial Number 1111), 

Quantity of Each Item (normally 1) and Value for Customs Purposes (the original purchase 

price of the instrument). 

Place three (3) copies of your CI in an envelope and mark the outside CUSTOMS PAPERS 

ENCLOSED. Attach the envelope to the outside of the box. 

 

4. Choose a shipper and prepare the waybill. 

European Clients: ship your instrument to Aurora Scientific Europe in Dublin, Ireland. 

All other Clients: ship your instrument to Aurora Scientific Inc. in Aurora, ON, Canada. 

You may ship your instrument back to us via the courier of your choice or via parcel post. If 

possible we prefer that you ship via FedEx. You are responsible for both the shipping and 

brokerage charges so please mark the waybill accordingly. Please don't ship freight collect. 

Shipments sent freight collect will be received but you will be invoiced for the shipping 

charges when your instrument is returned. 

 

5. Prepare and send a purchase order. 

After we receive the instrument we will evaluate it and contact you with the estimated repair 

cost. We require a purchase order before we can repair and return your instrument. Please 

fax or email us the purchase order at your earliest convenience. 

 

Return Shipping Address: 

 

 

Canada, USA, Asia 

 

 

Europe 

 

Aurora Scientific Inc. 

360 Industrial Parkway S., Unit 4 

Aurora, Ontario, CANADA  

L4G 3V7  

Attn: RMA Returns 

Tel: +1-905-727-5161 

 

 

Aurora Scientific Europe 

Hilton House 

3 Ardee Road 

Rathmines, Dublin 6, Ireland 

Attn: RMA Returns 

Tel: +353-1-525-3300 

 

 

  

mailto:info@AuroraScientific.com
http://www.aurorascientific.com/contact/
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Appendix A - 610A File Structure  

Data File Structure 

 
DMCv5.0 Data File 

Sample Frequency (Hz): 5000 

Calibration Data: 

Channel AI0 AI1 AI2 AI3 AI4 AI5 AI6 AI7 AO0 AO1 

Units ° mN TTL      ° mN 

Scale (units/V) 2.005352 1000.000000 0.200000 0.000000 0.000000

 0.000000 0.000000 0.000000 2.005352 1000.000000 

Offset (units) 0.000000 0.000000 0.000000 0.000000 0.000000

 0.000000 0.000000 0.000000 0.000000 0.000000 

Test Comments: 

 

 

 

Test Data in Volts: 

 

Sample AI0 AI1 AI2 AI3 AI4 AI5 AI6 AI7 AO0 AO1 Stim 

0 -9.429405 -0.287263 -0.154864 -0.077631 -0.035445 -0.076009

 -0.044531 -0.252865 0.000000 0.000000 0 

1 -0.000723 -0.008836 0.648941 0.926720 0.238439 -0.008511

 -0.015001 -0.231123 0.000000 0.000000 0 

2 -0.000398 -0.006240 0.856302 1.315155 0.487661 0.095656

 0.024913 -0.195428 0.000000 0.000000 0 

3 -0.000398 -0.004293 0.839427 1.401474 0.681392 0.215724

 0.077483 -0.147725 0.000000 0.000000 0 

4 -0.000398 -0.003644 0.753108 1.356692 0.817361 0.338063

 0.140113 -0.092559 0.000000 0.000000 0 

5 -0.000398 -0.005591 0.651213 1.277512 0.905627 0.452939

 0.211505 -0.032525 0.000000 0.000000 0 

6 -0.000074 -0.003319 0.575927 1.198657 0.958197 0.554834

 0.286466 0.032052 0.000000 0.000000 0 

7 -0.000723 -0.001372 0.483767 1.056198 0.968906 0.638232

 0.361427 0.102146 0.000000 0.000000 0 

8 -0.000398 -0.001372 0.383169 0.893295 0.944243 0.699889

 0.430548 0.172564 0.000000 0.000000 0 

9 -0.000074 -0.001047 0.298473 0.743373 0.895567 0.740128

 0.493502 0.242009 0.000000 0.000000 0 

10 0.000251 -0.000074 0.229677 0.611298 0.832288 0.758625

 0.546397 0.308208 0.000000 0.000000 0 

 

Protocol File Structure 

 

DMCv5.3 Protocol File 

Input Sampling Frequency: 2000Hz 

Output Sampling Frequency: 2000Hz 

Protocol Type: Unitized 

Wait(s) Then(action) On(port) Units Parameters 

1.000000 Stimulus Length Out 0,100,10,5,1  

1.000000 Trigger Length Out 1  

1.000000 Trigger Length Out 2  

1.000000 Trigger Length Out 3  

1.000000 Trigger Length Out 4  

1.000000 Trigger Length Out 0  
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Sequencer File Structure 

 
DMCv5 Sequence File 

Base File:  ECC_EDL 

Protocol File Timed? TimeToWait FileMarker 

C:\20HZ_FF.dpf Timed 300.000 a  

C:\40HZ_FF.dpf Timed 300.000 b  

C:\60HZ_FF.dpf Timed 300.000 c  

C:\80HZ_FF.dpf Timed 300.000 d  

C:\100HZ_FF.dpf Timed 300.000 e  

C:\120HZ_FF.dpf Timed 300.000 f  

  

Log File Structure 

 
12:27:31.253: DMC Opened, verified Activation 

02:42:07.186: DMC Opened, verified Activation 

02:42:16.629: User Comment:   Here is an example comment! 

02:46:20.391: DMC Opened, verified Activation 

02:46:30.514: Started Test 

02:46:39.315: Saved Data File to: C:\Users\ASI\Desktop\test2.ddf 


